Chapter 14
Imaging Neural Architecture in Brainbow Samples
Douglas H. Roossien and Dawen Cai
Abstract
The ﬂuorescent protein revolution has made the light microscope the most widely used tool for studying
biological structure from the single-molecule to whole organism scales. However, traditional approaches
are limited in their ability to resolve components in highly complex structures, such as the brain. In recent
years, this limitation has been circumvented by the development of multicolor labeling methods, termed
Brainbow. Brainbow tools rely on site-speciﬁc recombinases to make stochastic “choices” between different
combinations of ﬂuorescent proteins so that structures in close proximity to one another can be resolved
based on their color proﬁle. These new approaches, however, call for more reﬁned methods of sample
preparation and imaging optimized for multispectral imaging, which are presented here. The most robust
approach for generating useful Brainbow data combines immunohistology with multispectral laser scanning
confocal microscopy. This chapter, therefore, focuses on this particular technique, though the imaging
principle discussed here is applicable to other Brainbow approaches as well.
Key words Brainbow, Multispectral imaging, Immunohistology, Neuroscience, Development,
Confocal microscopy, Linear unmixing

1

Introduction
The impetus for the original Brainbow designs was the desire to
comprehensively study neuronal circuitry in the brain using the
light microscope. Individual neurons in the brain can have
immensely complicated morphologies, which can confound visualizing how processes from different neurons integrate into functional circuits. Traditional light microscopy approaches for tracing
whole neuronal morphologies used labeling methods such as the
Golgi stain, single-cell dye injections, or genetic expression of
ﬂuorescent proteins, but all rely on sparse labeling of cells to be
able to unambiguously identify the ﬁne, often interwoven, processes as belonging to a particular neuron. The ﬁrst Brainbow
designs adopted by Livet and colleagues therefore sought to label
neurons in close proximity with unique color labels by expressing a
different random combination of ﬂuorescent proteins (FPs) in each
neuron [1]. To achieve this they utilized the Cre/Lox site-speciﬁc
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Fig. 1 Schematic of a generic Brainbow construct. Expression of Brainbow is prohibited by a transcriptional
stop signal just downstream to the promoter. Alternatively, a default epitope or FP followed by a polyadenylation (pA) signal can be used. This is ﬂanked on the 50 side by each of three incompatible recombination target
sites (e.g., Lox or Frt sites) shown here as red, green, and blue triangles. Just 30 to the stop signal is the ﬁrst of
the three incompatible target sites. If recombination occurs between these two sites, the stop signal is
removed and the ﬁrst FP is expressed (RFP in this example). The pA prohibits transcription of the other FPs
remaining in the cassette. The second target site (green triangle here) is placed just after the ﬁrst pA. If
recombination occurs between these target sites, the stop and the RFP are excised resulting in GFP
expression. The same design is repeated for BFP expression

recombination system, notably the inability of Cre to excise/invert
DNA sequences ﬂanked by mutated (or “incompatible”) Lox sites
[2]. By placing three incompatible Lox sites 50 to a default FP and
ﬂanking each of the three subsequent FPs with one of the three Lox
sites, stochastic recombination occurs between one pair of the
incompatible Lox sites and excludes further recombination (see
Fig. 1). The default FP is removed, and the resulting product
expresses only one of the remaining FPs due to polyadenylation
signals after each FP coding sequence (see Fig. 1). Color outcome
diversity was then increased by integrating multiple copies of the
Brainbow construct into the mouse genome, effectively mimicking
a television screen mixing red, blue, and green hues in each neuron
[3]. Since the original Brainbow, several different modiﬁcations
have been made to either improve the system or to adapt it to
particular needs/biological systems. Some examples include choosing brighter FPs with more easily separated emission spectra [4],
cellular compartmentalization of FPs [5], different recombinases
[4, 6, 7], and different species/vectors [4–6, 8–12]. See Weissman
and Pan [13] for thorough review of available Brainbow tools.
Regardless of the modiﬁcation, almost all depend on stochastic
recombination events occurring independently in each cell.
For the second generation of Brainbow tools [4], membranebound instead of cytoplasmic FPs were used to produce homogenous labeling even in the ﬁnest axonal and dendritic structures. FPs
were speciﬁcally chosen to allow for combinatorial immunohistology. For this approach, each FP serves as an antigen for a different
non-cross-reactive primary antibody. Immunolabeling these samples
produces much higher ﬂuorescence intensity for two reasons: (1) the
ﬂuorophores conjugated to secondary antibodies are typically
brighter than FPs and (2) the use of polyclonal primary antibodies
“ampliﬁes” the signal by attaching multiple ﬂuorophores to each FP.
This is especially important for plasma membrane-bound FPs, which
can appear dim due to the reduced volume of FP within and near an
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illumination plane. There are several other distinct advantages to the
antibody ampliﬁcation approach: the ﬂuorophores can be speciﬁcally
chosen for compatibility with the optics of available microscopes;
multispectral imaging is easier with dyes than FPs as they span wider
emission spectral range, provide high signal-to-noise ratio, and are
more resistant to photobleaching. While the choice of which
Brainbow tool is best suited for the biological question at hand is
beyond the scope of this chapter, Table 1 provides a comprehensive
list of currently published Brainbow tools and which of them are
compatible with antibody ampliﬁcation. Noncompatibility is due to
common antigenicity of FPs in the system; for example, EGFP and
EYFP both serve as antigen for the same primary antibody. If the
speciﬁc Brainbow tool of choice is not antibody compatible, the
general principles discussed in the notes from Subheading 3.2
below can still be used to guide image acquisition.
This chapter outlines detailed steps required for immunolabeling
four-color Brainbow samples generated from injection of Credependent Brainbow adeno-associated viruses (AAV) [4] into a
transgenic Cre mouse. Following this, a detailed protocol is presented for multispectral imaging of these samples with a laser scanning confocal microscope. Lastly, steps to perform linear unmixing
of two of the speciﬁc ﬂuorophores in this example are presented.
While other microscope systems can be used for image acquisition
(such as epiﬂuorescent, spinning disk confocal, multiphoton excitation, or light sheet microscopes), the laser scanning confocal microscope provides optimal resolution in all three dimensions, more
ﬂexible in ﬁne-tuning imaging parameters, and are generally more
accessible to researchers than light sheet microscopes. In general,
Brainbow AAV can produce more hues in a sample than a transgenic
animal with a few tandem cassettes inserted into the same genomic
locus. This is due to [1] many AAV particles that can infect in the
same cell, and [2] while inter-cassette excision can happen in the
animal with strong and prolonged Cre activity to reduce the total
Brainbow cassette number, the Brainbow cassettes in different AAV
particles are exempt from such excision. Moreover, as the Brainbow
AAV can also be co-injected with a Cre-expressing AAV, this strategy
can be used in any model organism that is subjected to AAV infection. Therefore, this approach is the most robust and accessible way
to achieve the highest-quality three-dimensional image data sets
from Brainbow samples.

2

Materials
Prepare all solutions in deionized water. Be sure to follow proper
chemical waste disposal guidelines, especially regarding paraformaldehyde and sodium azide.
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Rosa26
knock-in

Rosa26
knock-in

Transgenic

R26-Rainbow [20]

Rainbow [21]

Ubow [22]

Transgenic

Transgenic

Transgenic

Flybow 1.1 [6]

Flybow 2.0 [6]

dBrainbow [11]

Drosophila

Rosa26
knock-in

Transgenic

FLPbow 1 [4]

Confetti [8]

Transgenic

Brainbow 3.2 [4]

Transgenic

Transgenic

Brainbow 3.0 [4]

Autobow [4]

Transgenic

Brainbow 2.1 [1]

Transgenic

Transgenic

Brainbow 1.1 [1]

FLPbow 2 [4]

Transgenic

Genome
integration

Brainbow 1.0 [1]

Mouse

Tool (ref)

Table 1
Currently available Brainbow tools

Cre

FLP

FLP

Cre

Cre

Cre

Cre

Cre

FLP

FLP

Cre

Cre

Cre

Cre

Cre

Gal4/UAS

Gal4/UAS

Gal4/UAS

UbiC

CMV/B-act

CAG

CAG

Thy1

Thy1

Thy1

Thy1

Thy1

Thy1

Thy1

Thy1

Recombinase Promoter

N
N

RFPmem, YFPmem, CFPmem
RFP, CFPmem, GFPnuc, YFP

None

lamin-2xHA

EGFPmem

tdTomato

tdTomato

mCherry

N

N

EGFPmem, mCitrinemem, Ceruleanmem,
mCherrymem
EGFP, EBFP, mKO2

N

N

N

N

EGFPmem, mCitrinemem, Ceruleanmem,
mCherrymem

YFP, CFP

mCerulean, YFP

mOrange, mCerulean, EGFP

N

YFP, CFPmem, RFP

GFPnuc

Y

mCerulean, PhiYFP, mK2

Crea

Y

Y

Y

mOrange2mem, EGFPmem, mK2mem

PhiYFP, ECFP

mOrange2mem, EGFPmem, mKate2mem

NFPnuc

tdTomato

NFPnuc

Y

N

Antibody
compatible

YFP, CFPmem

Outcomes

mOrange2mem EGFPmem, mK2mem

GFPnuc

OFP

RFP

Default
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Transgenic

Transgenic

Transgenic

TIE-DYE [24]

MCFO [25]

Raeppli [7]

Transgenic

Transgenic

ubi:Zebrabow [27]

PriZm [28]
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NA

Transduction

NA

HSV-Brainbow [9]

RGB LeGO
(lentivirus) [29]

Rainbow PRV [10]

Transposase
insertion

Transposase
insertion

Transposase
insertion

Transposase
insertion

Cytbowf [5]

Nucbowf [5]

Palmbowf [5]

Mitbowf [5]

rDNA vectors

NA

Brainbow AAV [4]

Viral vectors

Transgenic

Brainbow (gal4)
[26]

Zebraﬁsh

Transgenic

LOLLibow [23]

Cre

Cre

Cre

Cre

None

None

Cre

Cre

Cre

Cre

Cre

PhiC31

FLP

FLP

Creb

CAG

CAG

CAG

CAG

CMV

SFFV

VGLUT1

EF1α

B-act

ubi

Gal4/UAS

Gal4/UAS and/or
LexA/LexO

Gal4/UAS

Act5C + Gal4/UAS

Gal4/UAS

EBFP2nuc

EBFP2nuc

EBFP2nuc

EBFP2nuc

None

None

EmGFP

None

tdTomato

tdTomato

tdTomato

None

None

None

OFP

Y

TagBFP, mTFP1, mOrange, mKate2d

tdTomatomito, mCeruleanmito, EYFPmito

tdTomatomem, mCeruleanmem, EYFPmem

tdTomatonuc, mCeruleannuc, EYFPnuc

(continued)

N

N

N

N

Ye

ECFP, mTFP1, EGFP, EYFP, mCherryd

tdTomato, mCerulean/mTq2, EYFP

N

N

Y

N

N

mCherry, Venus, mCerulean

mOrange2, LSSmKate2, EBFP2

EYFPmem, TagBFPmem, mTFP1mem,
mCherrymem

Cerulean, YFP

Cerulean, YFP

N

Y

smGFPmyc, HA, V5, FLAG, OLLASc

Cerulean, YFP

Y

N

GFPnuc, LacZnuc, RFP

mCherry, EYFP, mCerulean
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Cre

Cre

Cre

35S

actb2

CAG

Recombinase Promoter

vYFPnuc

None

None

Default

CyPetER, TagRFPER

EBFP2, Cerulean, EGFP, mCitrine,
mKO, tdTomato, mKate2

mSapphire, EGFP, EYFP, mCherry

Outcomes

N

Ye

N

Antibody
compatible

The table is organized by species. For those using transposase insertion into the genome, electroporation is used as the method of plasmid delivery. The default state of each design
is what is expressed in the absence of the recombinase, some of which are nonﬂuorescent but can act as an antigen for immunohistology
Nuc nuclear targeted, mem membrane targeted, ER endoplasmic reticulum targeted, mito mitochondria targeted, PRV pseudorabies virus, HSV herpes simplex virus, AAV adenoassociated virus, rDNA recombinant DNA plasmid
a
Cre is expressed transiently until recombination, at which point it is self-excised
b
Used in combination with light-inducible split Cre
c
Spaghetti monster GFPs (smGFPs) act as epitope scaffolds for immunolabeling. MCFO uses epitope combinations selected from ﬁve smGFPs. Each with a different epitope tags
d
Multiple cellular domains available for all FPs
e
With proper combination of FP units (see Table 2)
f
These constructs, used separately or together, comprise the MAGIC system

Bro. of Brainbow
[12]

Transgenic

Transposase
insertion

Multibow [31]

Arabidopsis

Transposase
insertion

Genome
integration

CLoNe [30]

Tool (ref)

Table 1
(continued)
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1. 0.1 M phosphate-buffered saline, pH 7.4 (PBS).
2. 4% paraformaldehyde (PFA): In a chemical fume hood, add
16% w/v PFA to water. Gently stir while heating until temperature reaches 55–60  C. Slowly add 1 M NaOH to raise the pH
until the PFA completely enters the solution (should turn
clear). Slowly readjust the pH back to 7.4 with 1 M HCl.
This stock solution can be stored at 20  C for several months.
Just prior to use, thaw 16% stock at 50  C until clear, and then
dilute to 4% in PBS. This can be stored at 4  C for 1–2 weeks, at
which point it begins to degrade.
3. Vibratome (Leica VT1000S or other compatible models).
4. 12-well plate (or similar staining vessel).
5. Orbital shaker.
6. StartingBlock, PBS variant (Thermo Fisher).
7. Triton X-100.
8. Heparin.
9. Sodium azide.
10. Primary antibodies: chicken anti-EGFP, rabbit anti-mCherry,
rat anti-mTFP1, and guinea pig anti-TagRFP (see Note 1).
Dilute all primary antibodies together in one cocktail at
1:500 in PBS with 0.5% Triton X-100, 0.2% sodium azide,
and 10 μg/mL heparin (see Note 2).
11. Paraﬁlm “M” wax ﬁlm.
12. Highly cross adsorbed (see Note 3) secondary antibodies (see
Note 4): donkey anti-chicken IgY Alexa488 (Jackson ImmunoResearch), donkey anti-guinea pig IgG CF555 (Sigma
Aldrich), donkey anti-rat IgG Alex594 (Jackson ImmunoResearch), and donkey anti-guinea pig IgG CF647 (Sigma
Aldrich). Dilute all secondary antibodies together in one cocktail each to a ﬁnal concentration of 2 μg/mL in PBS with 0.5%
Triton X-100, 0.2% sodium azide, and 10 μg/mL Heparin (see
Note 2).
13. Vectashield anti-fade mounting medium (Vector Labs).
14. Glass microscope slides.
15. #1.5 (170 μm) coverslips.
16. Nail polish or coverslips sealant.

2.2 Image
Acquisition

1. 488/543/633 dichroic.

2.3

1. Fiji (NIH).

Linear Unmixing

2. Laser scanning confocal microscope with 488, 543, and 633
laser lines.
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Methods
Immunohistology

1. Following your institute’s guidelines for animal care, perfuse
the mouse under heavy anesthesia with cold PBS followed by
cold 4% PFA. Dissect the brain and postﬁx in 4% PFA with
gentle shaking at 4  C overnight. Wash brain with PBS for 1 h
with gentle shaking at room temperature (see Note 5).
2. Using a Vibratome, cut brain sections up to 100 μm in thickness (see Note 6) in the preferred orientation. Collect sections
serially in wells of a 12-well plate, returning to the ﬁrst well
after adding sections to every well.
3. Incubate sections in StartingBlock (PBS) with 1.0% Triton X100 for 4 h at room temperature with gentle shaking (see Note
7). This serves as both the blocking and permeabilization step.
12-well plates can be used as the staining vessel, though it is
recommended to keep at most two sections (with 600 μL of
solution) to three sections (with 750 μL of solution) in each
well.
4. Wash in PBS with 0.5% Triton X-100 at room temperature with
gentle shaking three times for 30 min each.
5. Add primary antibody cocktail to sections, wrap plate with
paraﬁlm, and incubate at 4  C with gentle shaking for
3–7 days (see Note 8).
6. Wash in PBS with 0.5% Triton X-100 at room temperature with
gentle shaking three times for 1–2 h each.
7. Add secondary antibody cocktail to sections, wrap plate with
paraﬁlm, and incubate at 4  C with gentle shaking for 1–5 days
(see Note 9).
8. Wash in PBS with 0.2% Triton X-100 at room temperature with
gentle shaking twice for 2 h each.
9. Perform a ﬁnal wash in PBS at room temperature with gentle
shaking for 2 h.
10. Place tissue section on a microscope slide, gently remove excess
PBS, and mount sections in excess Vectashield mounting
medium (see Note 10) between microscope slide and #1.5
coverslips. Place a 2.0 mL microcentrifuge tube ﬁlled with
water, inverted, on top of the coverslip. Store sample protected
from light at room temperature overnight (see Note 11).
11. Use vacuum suction or a Kimwipe tissue to remove excess
Vectashield from around the coverslip. Seal the sample with
clear nail polish. Tissue can be imaged immediately or stored at
4  C protected from light for at least 1 year.
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The methods described here are optimized for secondary antibodies conjugated with Alexa488, CF555, Alexa594, and CF647 (see
Fig. 2). If using Brainbow samples containing only three FPs, it is
best to omit the Alexa594 to eliminate the need for linear unmixing
of the 594 and 647 emission signals (see Subheading 3.3).
1. Choose the microscope objective (see Note 12).
2. Set pixel dimension in (x, y) (see Notes 12 and 13).
3. Set the Z-step interval (see Note 14).
4. Place the 488/543/633 dichroic in the beam path.
5. Set the minimum and maximum Z coordinates.
6. Set emission collection ranges for each channel (see Fig. 2). Collect Alexa488 emission between ~500 and 530 nm (Channel 1),

a
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Fig. 2 Imaging spectra. (a) Excitation spectra (dashed lines) and excitation wavelengths (vertical solid lines) for
chosen dyes. (b) Emission spectra and collection ranges (gray boxes). For clarity, these emission spectra
represent the maximum emission efﬁciency and are not normalized to the particular laser lines used for the
acquisitions described here. These spectra were generated using Thermo Fisher’s Fluorescence SpectraViewer using the Alexa version of these four dyes (their CF counterparts have similar spectra)
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CF555 between ~560 and 590 nm (Channel 2), Alexa594
between ~600 and 630 nm (Channel 3), and CF647 between
~640 and the upper limit of detector (Channel 4).
7. Separate lasers and emission channels into two separate acquisition tracks, 488 and 633 laser lines with Channels 1, 3, and 4
onto Track 1, and assign the 543 laser and Channel 2 onto
Track 2 (see Note 15).
8. Set pinhole diameter to match the diameter of the expected
Airy disk for optimal signal-to-noise ratio (see Note 16). Some
acquisition software, such as Zeiss’ Zen, can set this automatically, or it can be calculated with the following equation [14]:
d Airy ¼

1:22  λ
M C
N:A:

where λ ¼ mean wavelength of the three excitation lasers, N.A.
is the numerical aperture of the objective, M is the magniﬁcation of the objective, and C is the magniﬁcation of optical
components in the confocal head (different for each confocal
system but can be obtained from the manufacturer).
9. Set the gain on the detector (see Note 17).
10. Set the laser power for each laser (see Note 17). Because a large
proportion of emitted photons from the Alexa594 ﬂuorophore
will be collected in Channel 4, adjust the laser power for both
ﬂuorophores according to the Channel 4 intensity alone
(Channel 3 can appear comparatively dim until unmixing). If
the acquisition software has a function for correcting intensity
in depth, set the optimal laser power at the top and bottom of
the Z-stack. This will compensate for the loss of excitation due
to light absorption and scattering through the tissue.
11. Set the refractive index correction ratio by dividing the refractive index of the mounting medium (1.45 for Vectashield in
this case) by the refractive index of the submersion media (oil,
water, air, etc.).
12. Set the pixel dwell time and use averaging across two scans (see
Note 17). For this step it is best to take a few scans using
different dwell time/averaging settings to determine the minimum scan time required for the desired image quality.
13. Run the acquisition, checking occasionally to be sure the system has not failed.
3.3

Linear Unmixing

For the ﬂuorophores and parameters described here, some unmixing must be done post-acquisition to effectively remove the
Alexa594 emission from Channel 4 and add it back to Channel 3
(see Fig. 3). In confocal microscopes equipped with array spectral
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detectors, such as the Zeiss LSM780 or LSM880, this can be done
using lambda scan mode combined with “online ﬁngerprinting”
function. The image processing steps below will be required for
other microscope systems. These instructions are intended for the
Fiji version of ImageJ [15]:
1. Directly apply ~5–10 μL of a 1:500 dilution of Alexa594 secondary antibody directly to a coverslip and mount to a slide.
2. Acquire a reference image from this slide using the exact same
imaging settings as in Subheading 3.2 for Channels 3 and 4
except for the laser intensity, which can be adjusted (see Note
18). Again, the ideal image will have the maximum pixel values
~80% of the maximum dynamic range (see Note 17). For this
the Channel 1 and 2 should be omitted as should the 488 and

Fig. 3 Unmixing of Alex594 and CF647 emission. (a) Photon emission from Alexa594 (green) overlaps with
emission from CF647 (red) shown here in the yellow region. Gray boxes representing the emission collected in
Channels 3 and 4 demonstrate the large portion of Alexa594 emission collected in Channel 4 which can be
recovered through linear unmixing. (b) A reference spectrum is obtained by capturing an image of the
Alexa594 dye using identical imaging conditions. The area under the Alexa594 emission curve in each
channel (ICh3 and ICh4) is used to calculate the ratio of Alexa594 to CF647 emission collected in Channel 4
(yellow region under the gray Ch4 box in a) and to correct the values in the raw data. (c) The maximum Zprojection of an image stack prior to unmixing shows signiﬁcant overlap between Channel 3 (green) and
Channel 4 (red). (d) After unmixing the color separation is restored as evidenced by the large number of
structures that become a “pure green” color

dwcai@umich.edu

222

Douglas H. Roossien and Dawen Cai

543 lasers. Remove the slide and acquire a second image with
the same setting as background noise, this time using the same
laser power as the reference image as well.
3. Open each image in Fiji and run the “Process > Subtract Background” function for each, and then calculate the mean pixel
intensity across each of these two reference images. This can be
done using the “Analyze > Measure” tool. These values will
serve as IBG, ICh3, and ICh4 in steps 4–6.
4. Calculate the value α to use in steps 5–6:
α¼

I Ch4
I Ch3

5. Open Channel 3 from the Brainbow Acquisition in Subheading
3.2 as a Separate Image Stack. Apply the Following
Calculation:

Img 594 ¼ Img Ch3  I BG  ð1 þ αÞ
where ImgCh3 is the raw image stack and Img594 is the resulting
unmixed 594 emission image stack. This can be accomplished
in Fiji by ﬁrst choosing “Process > Math > Subtract” and
entering IBG. Next, use “Process > Math > Multiply” and
enter the 1 + α value. Save this as a separate new image stack
(Img594) as the original raw Channel 3 image stack will be
needed again in the next step.
6. Open the Original raw Channel 3 and Channel 4 Data as
Separate Image Stacks. Perform the Following Calculation:


Img 647 ¼ Img Ch4  I BG  Img Ch3  α
subtract IBG from ImgCh4 as in step 5. Then, being sure to select
ImgCh3 as theactivewindow, use the“Process > Math > Multiply”
function entering the value for α. Perform the ﬁnal subtraction
using “Process > Image Calculator (choose ‘Subtract’),” and
select the proper image stacks for the operation. Save this as a
new image stack (Img647).
7. Open Channel 1, Channel 2, Img594, and Img647 as separate
image channels, and use the “Image > Color > Merge Channels” to make a new composite image stack.
8. If signal intensity varies greatly along the Z axis, perform histogram matching to produce homogenous color in depth. Add a
slice to the very front of the image stack: “Image > Stacks > Add
Slice (check ‘Prepend’).” Next, ﬁnd a slice in which one channel has the best overall contrast. Select that channel and select
the whole image frame, copy the content of that channel, and
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Fig. 4 Displaying four channel images. (a) Images can be displayed by either combining two channels into one
display color or by toggling displaying one of two channels assigned to the same color (compare (b) and (c))
Table 2
Antigenicity of primary FP antibodies
Antibody

Validated antigens

Chicken, anti-EGFP IgY

EBFP2, ECFP, Cerulean, Venus, mCit, EGFP, sfGFP, EYFP,
mAmetrine

Rabbit, anti-mCherry serum

DsRed, mOrange2, tdTomato, mCherry

Rat, anti-mTFP1 serum

mTFP1, mWasabi

Guinea pig, anti-TagRFPt
serum

TagBFP, TagRFP, TagRFPt, mKate2, tdKatushka2, eqFP650

While other FPs derived from similar species are predicted to serve as antigen for the same primary antibody (e.g.,
mEmerald and EGFP are both derived from Aequorea victoria and thus mEmerald is predicted to serve as antigen for the
chicken anti-EGFP primary), only these have been directly validated by the authors

paste it to the ﬁrst channel in the ﬁrst slice. Now run
“Image > Adjust > Bleach Correction (‘Match Histogram’),”
followed by “Plugins > Image Normalizer (‘Stack Maximum’).” Save as a new image stack.
9. The ﬁnal composite image stack can be viewed in a variety of
different color display conﬁgurations (see Fig. 4) (see Note 19),
but regardless adjustments to the brightness and contrast independently of each channel will likely be needed to give the best
color balance to the human eye.

4

Notes
1. While these were the puriﬁed FPs used to generate the primary
antibodies, the primaries also bind to FP variants derived from
the same organism species. See Table 2 for a complete list of FP
antigens for each of these primary antibodies. These four primary antibodies are custom produced in the Cai Lab and are
distributed through Kerafast. Though similar primary antibodies may be commercially available elsewhere, they need to be
validated with this protocol.
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2. The Heparin is optional, though it can decrease nonspeciﬁc/
background binding of antibodies in the tissue, most notable in
the blood vessels. This is especially important in sparsely
labeled samples where primary antibody can be in excess of
antigen.
3. Secondary antibodies should be cross adsorbed by the manufacturer to eliminate nonspeciﬁc binding to IgG from other
primary species.
4. The choice of secondary antibodies may vary depending on the
optics of the available microscope. The cocktail of secondary
antibodies in this protocol was chosen to optimize the speed of
image acquisition while limiting the amount of spectral cross
talk between ﬂuorophores (see Subheading 3.2). While Alexa
dyes can also be used in place of the two CF dyes here, there are
two notes of caution: ﬁrst, the CF647 is brighter than the
Alexa647, and second, while the Alexa546 has stronger excitation with 543 nm laser light, it tends to aggregate on the
surface of the tissue.
5. Brains can be stored in PBS with 0.2% sodium azide for at least
several months before or after sectioning. While ﬂuorescence
intensity may decrease during long-term storage, the antigenicity of the FPs still remains, and thus the tissue is still suitable
for immunohistology.
6. Floating sections are required for this histology protocol for
optimal antibody penetration through both sides of the tissue.
This protocol can reliably achieve complete antibody penetration through a 100 μm brain section from mice up to
~4 months of age. Over the lifetime of the mouse, lipid accumulation in the brain hinders complete penetration, and thus
60–80 μm sections are recommended for older mice. While the
prevalence of whole organ and/or thick tissue immunohistology and clearing techniques is rapidly increasing, they are still
improving and emerging and are therefore omitted from this
protocol for simplicity. If imaging of thicker sections is desired,
other methods, such as 3DISCO [16] and iDISCO (nonmethanol variation) [17], can be used in place of this protocol
for immunohistology. One caution to note is that when using
clearing techniques such as CLARITY [18], which use harsh
detergent conditions to strip lipids from the tissue after crosslinking proteins to a gel-like matrix, much of the plasma
membrane-bound protein (such as those used in many Brainbow reagents) are often removed as well. Therefore, it is
recommended to immunolabel tissue prior to clearing.
7. The StartingBlock product produces superior results compared
to other blocking reagents (i.e., various serums) as this proprietary formula purportedly blocks against nonspeciﬁc binding
from antibodies raised in most commonly used species.
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8. The incubation time depends on the thickness of the section
and the age of the mouse from which it was collected (in other
words, the amount of lipid in the brain), both of which can
hinder complete and homogenous antibody penetration
through the sample. For 100 μm sections from adult mice
2–4 months of age, incubate for 7 days; for thinner sections
from adult mice, incubate for 5 days; for sections from neonates, the incubation time can be shortened to 3 days regardless of thickness. Incubation times can be ~halved if incubations
are done at room temperature with gentle shaking, though
tissue degradation can occur if tissue ﬁxation is suboptimal. If
immunolabeling still appears incomplete in the middle of the
section, it is also possible that the antibodies are becoming
depleted before they reach the center of the tissue. It is therefore recommended to replenish and/or supplement with fresh
antibodies half way through the incubations or to increase the
volume of antibodies added to the tissue.
9. The incubation times for secondary antibodies can be shorter
than for the primaries because the binding afﬁnities are much
higher. Determining the time for the speciﬁc sample follows
the same general guidelines as in Note 5 for primary antibodies, but standard practice is ~half the time used for primary
antibody incubation.
10. Vectashield is an anti-fading reagent supplement, aqueousbased, nonsolid-forming mounting media with a refractive
index of 1.45. While mouse brain has a refractive index of
~1.48–1.49, laser light generally passes through sections up
to 100 μm with a manageable amount of scattering. It is also
available with DAPI if desired. Alternatively, RapiClear (SunJin
Labs), a nonsolid-forming mounting media with a refractive
index of 1.47, can be used to further increase the clearness of
sections [19] up to 300 μm thick.
11. Placing a weight on top of the section prevents it from curling
during the exchange of water/PBS in the tissue and glycerol in
the Vectashield.
12. One basic parameter to consider before setting up a confocal
image acquisition is the desired resolution/pixel size. This will
largely depend on the speciﬁc biological question, but in general increasing resolution will come at a cost in acquisition time
and data size. While in some cases, these trade-offs may indeed
be trivial, in circumstances where imaging a large volume of
tissue is desired, acquisition times can extend over periods of
days, while data size can easily reach the hundreds of gigabyte
scale. In addition, increasing scan time per frame increases the
risk of photobleaching the sample.
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13. While the minimum (x, y) pixel size in diffraction-limited
microscopy is ~200 nm, oversampling to about 100–150 nm
is optimal if deconvolution is to be used in post-acquisition
processing.
14. The axial resolution in the confocal system depends on the
numerical aperture of the objective and the size of the pinhole.
In practice, it is generally assumed that the maximum resolution in the Z dimension is approximately twice the X and Y
resolution. Therefore the minimum Z-step size should be
about twice the size of the (x, y) pixel size. If performing
downstream deconvolution, oversampling is recommended in
Z as well.
15. Acquisition tracks allow for excitations and emissions to be
collected independently from one another. This prevents ﬂuorophore cross talk as CF555 can be excited by 488 nm laser light
and CF555 emission will bleed into the Alexa594 emission
range. Tracks use either a “line switching” mechanism, in
which the lasers and channels are alternated after each line
scan in X across the frame, or a “frame switching” mechanism
where each entire frame is collected before switching tracks. If
unable to use a single dichroic for excitation as described here,
frame switching is required and can more than double acquisition time owing to the need to physically change the dichroic
mirror between each track.
16. Dim samples may beneﬁt from an increased pinhole beyond the
Airy disk diameter at the expense of decreased resolution. This
is especially true for sparsely labeled samples where interference
from out-of-focus light is less of a concern.
17. There are a variety of illumination/detection parameters that
contribute to the overall signal-to-noise ratio. Which settings
are optimal will depend on how bright the sample is and how
much noise can be tolerated for each particular experiment.
The main contributing factors are the gain on the detector, the
laser power, and the pixel dwell time (i.e., speed of scanning).
Setting a high gain on the detector will increase image signal
but at the cost of increasing noise. This can be offset by using
longer pixel dwell times and/or averaging multiple scans, but
this comes at the cost of acquisition time. Increasing laser
intensity is the simplest way to maximize the signal-to-noise
ratio, yet photobleaching can become an issue in thicker samples. While it is often in the user’s best interest to obtain the
strongest signal from the sample, it is important to set parameters properly so that the maximum pixel intensity in the
image is equal or smaller than 80% of the total dynamic range
to assure the strong signals fall into the detector’s linear detection range. For example, the dynamic range of a 12-bit image
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contains a maximum intensity value of 4000, so the highest
pixel value in the image should be ~3200. This is particularly
important if unmixing is to be performed as saturation of
detector will cause unmixing errors.
18. What will be calculated for unmixing Channel 3 and 4 is the
ratio between the areas under the 594 and 647 emission curves
collected in Channel 4 (see Fig. 3). In order to keep the
unmixing parameter as a constant, all imaging parameters,
with the exception of laser power, must be unchanged between
taking the reference images and sample images. While changing laser power will proportionally change the intensity in
Channel 3 and 4 (i.e., constant ratio), changing other parameters will have nonlinear effects to the average intensity in
each image.
19. As a computer monitor can only compose pixel outputs based
on red, blue, and green channel information, special consideration needs to be made for displaying data from four channels/
colors. There are two ways to approach this: one is to combine
two channels to the same color and display all four simultaneously. However, this limits the true power of four-color
Brainbow labeling. An alternative approach is to assign two
channels to the same color and toggle between displaying only
one of them when trying to resolve color ambiguities between
structures from different cells (see Fig. 4).
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